FED2 BASIC WORKBENCH MANUAL
Updated 24 September 2016
PART 1 - YOUR NEW PLANET

1.1 INTRODUCTION

When Fed2 players get to the rank of Founder, you get to own a planet which other players can visit and explore. You can use one of the stock planets which we provide and have it linked into the game automatically, but it’s much more fun to exercise your creativity and design your own planet - either by linking one of the stock planets and then modifying the files, or doing a completely original design of your own.

To do that, you use the Fed2 Workbench, a set of tools with which you design the planet. This manual tells you how to use the Workbench.

The basic Fed2 Workbench tools are quite intuitive so you will probably be able to figure out how to do a lot of things just by experimenting. However, at some point you really do need to read this manual, because there are some things about designing a planet that you won’t be able to just work out on your own.

RTFM!

1.2 WHAT’S IN THE MANUAL

Part 1 of the manual gives you some of the basic information you need before you start work on designing your planet, including how to report problems, what restrictions there are on your planet, and how to get your planet put into the game.

Part 2 gives advice on how to design a planet, including the planet and space map you will need to create, where to put facilities on your planet, how to give players directions, how to check your work, what the editors do with illegal characters, and custom events.

Part 3 introduces you to the Workbench tools, and explains how to name your system and planet, what filenames to give the data files, how to install the Workbench on your computer, and how to save your work.

Part 4 teaches you how to use the location editor to create your planet map and space map. It explains the layout of the screen, how to add locations to the map, setting movements, specifying information about locations, information for the whole map, how to add a second planet to your system, and the controls that let you edit individual locations and save and load maps.

Part 5 explains how to use the Tesla planet checker to spot errors in your files.

Part 6 teaches you how to use the message editor, and includes an explanation of the concept of categories, sections and message numbers, the layout of the screen, how to write a message, how to use the messages you write, how to edit messages, and save and load the message file.

Part 7 is a checklist of the things that you need to get right in order for your planet to be linked into the game.

Throughout this manual, instructions to click on a button are in single quotes and italics, like this: click the ‘OK’ button. Instructions to type a combination of keys on your keyboard are also in quotes and italics: ‘Ctrl-S’  which means hold down the Control key while you press S. When you need to use a menu item, the instructions are in the form: select ‘File|Save’ which means select the Save item from the File menu.

1.3 REPORTING PROBLEMS

Fed2 is still in development, therefore what you can do when designing planets is changing, as are the tools you use to do them. If you find a bug in the tools it’s important that you report it, otherwise we won’t know about it and it won’t get fixed. Similarly, if there is something you wish worked differently, or you have any suggestions for changes to the tools, please let us know.

If there is anything about this manual that you think needs to be changed - typos, mistakes, things that aren’t explained clearly enough - they need to be reported too.

Please send your bug reports and suggestions to feedback@ibgames.net. Don’t forget to put fed2 somewhere in the subject line to avoid our spam filters.
1.4 RESTRICTIONS

Exactly what restrictions you have on designing a planet will vary depending on your rank. Founders can edit the map file and the message file using the location editor and the message editor. Later ranks get more capabilities.

The number of locations in your system goes up as you advance through the ranks, too. A basic star system has two maps - the space map and the planet map. Founders are limited to 50 locations in total. It’s up to you how you allocate the 50 locations across your two maps, so long as the planet map has at least 2 locations. The space map doesn’t have to have more than 1 location, therefore your planet can have 49 if you want.

The next rank, Engineer, is allowed 30 extra locations, giving a total of 80.

Moguls can add a second planet to the star system, and the location allowance is increased to 130.

Later ranks get even more planets with a correspondent increase in the location allowance.

Technocrats will be able to add events to your planet to make interesting things happen, and add objects too, using the event and object editors. How to use those editors is covered in the Advanced Workbench Manual which you can download from the ibgames website here: http://www.ibgames.net/fed2/workbench/windows/index.html.
Each rank can buy an increase in locations if you wish to expand your planet before promoting. Two slithy toves gives you 30 extra locations, so Founders can have 80 and Engineers 110. Moguls with their two planets can pay for an expansion for each world (in other words, 60 extra locations for four slithy toves) giving a possible 190 locations in your system.

1.5 FOLLOW THE RULES

You must follow the Fed2 rules when designing your planet. The same rules apply to text used on your planet, as they do on messages on the comm channels - no vulgarity or sexual content, no insults to other players, and so on.

Being able to modify your planet is a privilege, not a right, and if you abuse it then the privilege will be taken away, and your planet will revert to a stock planet.

1.6 PUTTING YOUR PLANET INTO THE GAME

In order to have your planet put into the game, you must be a Financier. If you don’t auto-link a stock planet into the game, then when you reach that rank and you have finished working on your planet files, email them to feedback@ibgames.com (and don’t forget to put Fed2 in the subject line, to avoid being eaten by our spam filters). Please give the following information in your email:

· Your Fed character name
· The system name
· The planet name
Although you can use the Workbench at any rank, and get your planet files ready well in advance of promoting to Financier, please do not mail them in before you reach that rank.

When we receive your files, we check them for serious errors and if they pass, Alan links them into the game. This is a manual process and is quite time-consuming, so you may have to wait several days – it’s usually done at weekends. If there is more than one new planet in the queue, the files will be linked in the order they were received.

Having mailed the files to feedback, you should then stop work on your planet. Don’t make any more changes to your files until the planet actually opens up in the game. The reason is that we may need to make some alterations to the files in order to get them to work properly, and if so we will mail you back a copy of the amended files. You should save the files we send you in the same place on your computer as the files you sent to feedback - you want to overwrite your original files with the changed version. Then you can carry on working and make further changes to the planet if you wish.

If you don’t do this, then your copy of the files and the one Alan has put into the game will be out of sync, and as a result one of two things will happen: either you will lose the further changes you have made, or you will lose the changes that Alan made. The former is annoying; the latter could be a disaster.

PART 2 - ADVICE ON DESIGNING A PLANET

2.1 INTRODUCTION

This part of the manual gives advice on how to design a planet, including the planet and space map you will need to create, where to put facilities on your planet, how to give players directions, how to check your work, what the editors do with illegal characters, and custom events.

2.2 BE ORIGINAL

If you intend to design a planet of your very own, you should come up with an original idea of your own. Don’t copy anybody else’s planet without their permission. You have our permission to use the locations of the stock planets as the basis for your planet if you want, but really it is much better to come up with something original.

Do not base your design on a work which is copyrighted by someone else. The most obvious example of this is that you should not write a planet based on your favorite novel, film or TV show.

You can refer in passing to someone else’s work - for example, the locations on StarBase1 in Arena Space include references to famous science fiction works - but you cannot base your whole planet on someone else’s ideas or plots.

You can write your planet as a homage to a particular work, without actually using any names or incidents from the work. For example, you could have a planet full of dragons ridden by humans, but you could not call it Pern or use any of the character names or plot lines from Anne McCaffrey’s books.

It is much more fun to be inventive and original. This is your chance to show off your creativity!

2.3 ABOUT SPACE MAPS

A star system consists of a space map and one (or more) planet maps. With a stock planet, the space location only has one location. This serves as both the Interstellar Link and the Orbit location, and means that when players jump through hyperspace to your system, they can immediately land on the planet without having to fly through space.

You can have more than one location on your space map if you want, but unless you have reached the stage of having more than one planet in your system, there is no real reason at the moment to add any more space locations. Once ship fighting is allowed then things will be different, of course!

2.4 NAMING YOUR SYSTEM AND PLANET

You give your planet, and the star system it is found in, names - they must be different. For this manual we are using planet name Bodville, system name Newstar. You can have more than one word in the planet or system name and they can be up to 32 characters long (including the spaces), but remember that players will have to type the system name in order to jump there, and the planet name for trading purposes, so don’t make it too long and complicated or else you might discourage visitors. The planet Zyxxxykghwlwggh isn’t going to be too popular.
The names can include numbers as well as letters but must start with a letter. You cannot use any punctuation marks in the name. The game will always refer to the names with initial capitals - for example New World - and you cannot enforce capitals anywhere else in the name.

For technical reasons, your planet name should never have the word space in it as a separate word, or at the start of the name. You could call your planet Hyperspace but not Spaced Out or Parking Space.

The names you choose should not break the rules - ie no obscene words. They should also not be anything that is going to cause confusion. For example, you should not call your planet Depot or Exchange. If we think there is a problem with the name you have chosen, we will ask you to come up with an alternative. If you’re not sure whether your name is acceptable - ask!

2.5 WHERE TO PUT THE FACILITIES

Since the purpose of having a planet is to encourage traders to visit and give you their money, you should make sure that the essential facilities are close to the spaceport. In particular, make sure the trading exchange is easy to find. You can do all kinds of confusing things outside of the core area of your planet, but players who just want to visit to trade shouldn’t have to go on a long trek or risk getting lost, unless you want to lose out on business.

Armstrong Cuthbert will automatically set up an office on your landing pad, so Captains can collect and deliver jobs to and from your planet. Akaturi jobs are confined to the Solar System.

2.6 DIRECTING PLAYERS

When you write the location descriptions, you need to include information to tell players which way they can move. Although some players use FedTerm which has auto-mapping and shows the available exits, not everybody does, so you need to design the planet for those people that do not. You want people to explore your planet, so make it easy for them to get around. Trying all the directions until you hit on the right one is just tedious.

If a player walks west into a building then it ought to be obvious that she should go east to get out again. However, you still need to indicate where the exit is, because she may have logged on in the room, or spent a while AFK, and have forgotten how she got in there.

2.7 BEWARE OF ONE-WAY DESCRIPTIONS

One-way descriptions means a set of locations where the descriptions assume that you are reading them in a certain order. For example, a long road might have descriptions that talk about it getting narrower... much narrower than it was... even narrower now... at its narrowest point. But if a player walks in the other direction she will read those descriptions in the opposite order, and they won’t make sense. You always need to keep in mind all the ways a player might get into a location.

2.8 CHECKING YOUR WORK

You want people to enjoy their visit to your planet, so you need to ensure that everything works right, otherwise players will be put off and won’t bother to come back. It also makes the game as a whole look bad if it is filled with planets that are nothing but typo after typo after typo.

When all you are doing is writing or editing locations, the main mistake you will have to worry about is typos and spelling errors. You can also mess up the movements - forget to link two locations together, or leave off the exit out of a room.

Yes, you are going to make mistakes - everybody does - but it is important to find the mistakes and fix them as soon as possible.

TESLA

The most important way to check your planet is to use the Tesla planet checker which checks your files for some of the errors that would stop your planet from being loaded into the game.

You MUST run your planet files through Tesla before submitting them, every time - even if you have only made a few tiny changes. It’s the first thing we do when we receive the files, and if Tesla shows up any errors, we’ll chuck the files right back at you to be corrected.

The Tesla program is included in the Workbench download, and the instructions on how to use it are found later in this manual.

SPELLING
Some people are good at spelling; some people are not. By and large, those that are not good at spelling don’t notice spelling mistakes in other people’s work, and therefore don’t understand the importance of using correct spelling.

But it is important, because to those who do notice spelling errors, a mistake can be very jarring. It can jolt the reader out of her absorption in whatever it is she is reading, and disrupt the flow of information. In addition, spelling mistakes make the game look like something produced by amateurs.

So you need to make sure there are no spelling mistakes in any of the descriptions or text that you write as part of your planet.

USING A SPELL-CHECKER
There’s no spell-checker built into the tools, but you can load the listing from the files into a word processing program and run it through a spell-checker. The manual tells you how to produce a listing when it explains how to use the editors.
However, be aware that spell-checkers are not fool-proof. They can only tell you about mistakes where they don’t recognise a word at all. They won’t be able to tell you where you have used the wrong word or left a word out altogether. They also won’t tell you if you’ve used the wrong version of a word that can be spelt in different ways: for example, there and their, hear and here. And they will throw up as errors things that are correct, particularly in location names or words invented just for Fed. It’s a rare spell-checker that knows what Katydidics are!

So using a spell-checker is only half the answer.

Warning: If you load the actual map or message file into a word processor in order to identify errors you MUST NOT make any changes to the files, or save them out. Simply note where the errors are then fix them using the appropriate editor. Word processors often insert their own special codes into text when they save it - Microsoft Word is particularly bad at this - which means the file may not load into the editor or into the game.

PROOF-READ YOUR WORK
As well as using a spell-checker, you need to read over your work, to make sure it says what you intended it to say, and find errors that are not spelling mistakes as such; for example, sentences that have a missing word or don’t make sense, or even locations for which you forgot to write a description.

When proof-reading you will find it much easier if you can print the work out. The human eye has a tendency to skate over words on the screen, and it will be more difficult to read what is actually there (rather than what you think ought to be there) on the screen than it would if you read a paper printout.

Besides, you can take a printout away from the computer to read elsewhere if you wish, and you can scribble on it to remind yourself what needs to be changed or fixed.

Another technique you may find useful is to start reading backwards from the end of your print-out, word by word. This prevents you from reading what you expect to see, rather than what is really there, so incorrectly spelled words are less likely to go unnoticed.

Of course, if you’re no good at spelling yourself, you may not be any good at proof-reading either. So try and find someone else to help you. Other players may be willing to check your work for you if you ask them.

Failing that, once your planet is in the game and people are walking around it, they will tell you about any errors they find and you can fix them.

WALK ROUND YOUR PLANET
Once your planet has been put into the game, you need to walk around it and make sure everything works as it should. Sometimes you only notice typos when you actually stand in a location and look around you. Check that if a description says that something is to the northeast, that’s where it really is (it’s very easy to get east and west the wrong way round).

Check that you can use the bar commands in all of your bars - if you can’t, it means you forgot to set the property. The same goes for any other locations that should have properties on them, such as the exchange (watch for the prices) and the hospital (type ‘INSURE’).

FED2 SIMULATOR

You can also walk around your planet before it has been added to the game, using a Fed2 Simulator program that has been written by one of the players, Filbert. You load your planet files into the simulator and you can then issue commands to walk around the map and check that everything works as you intended.

You can download the Fed2 Simulator from the Fed2 Workbench page on the ibgames web site here: http://www.ibgames.net/fed2/workbench/windows/fedsim/index.html.
2.9 CURLY QUOTES AND OTHER ILLEGAL CHARACTERS

The bit of the game code which deals with loading your planet files into the game when it fires up after reset is quite strict - and if your files contain any characters outside of the range it understands, it will stop loading the file at that point. If this happens, then any locations or messages in the file after the character it doesn’t like will just not show up in the game.

The game only understands the standard ASCII characters - that is, letters and numbers and the ordinary punctuation marks. Basically, it’s all the characters that show up on your standard keyboard. If you type all your location descriptions and messages directly into the editor then you shouldn’t have a problem. However, some word processing programs (and Microsoft Word in particular) try to be very helpful, and when you type text into them they will do their best to reformat it so it looks pretty. One of the things they do is to change the standard single- and double-quotes into curly quotes or what they call “smart” quotes. If you’re writing a letter to print out (or indeed writing this manual), this looks very attractive, but if you’re writing text to cut and paste into the editor, it is going to cause you problems - because those curly quotes are NOT standard characters. The same goes for characters with accents on them, or long dashes (en or em dashes as they are known to printers); they are not standard characters so the game won’t like them.

Because having half your locations vanish is a very serious problem, the editors do their best to stop things going that far. When you save your files, if they contain any illegal characters the editors will replace the illegal characters with either a ? or a #. When you proof-read your work, this should show up pretty prominently as an error so you will know that you have to put back the correct, legal character.

If you want to make sure you never have this problem, there are several different ways to prevent it:

· Never cut and paste text from Word - type it directly into the editor instead.

· If you want to type the text out before cutting and pasting it into the editor, don’t use Word - use a text editor that doesn’t try to do any fancy formatting on the text. Notepad that comes with Windows is fine.
· If you must cut and paste text from Word, make sure you have the formatting feature that converts ordinary quotes to “smart” quotes turned OFF. How you do this will vary depending on what version of Word you are using - in Word 97, you select AutoCorrect from the Tools menu, click the AutoFormat as you Type tab, then make sure the option to change “straight” quotes with “smart” quotes is unchecked; the options in Word 2003 are very similar. In Word 2010 it’s more complicated: click the File button, click Options, click Proofing, click the Autocorrect button, click the Autoformat tab and then untick the box next to “straight quotes” with “smart quotes”; then click the Autoformat as you type tab and untick the same box. Phew!
2.10 CUSTOM EVENTS AND OBJECTS

You cannot write events or put objects on your planet until you are a Technocrat. However, if you have an idea that you really want to put into practice before you reach that rank, you can commission Hazed to write the events and objects for you - she takes payment in slithy toves.

See http://www.ibgames.net/fed2/workbench/objects/index.html for the details.

PART 3 - USING THE TOOLS

3.1 INTRODUCTION

This part of the manual introduces you to the Workbench tools, and explains how to name your system and planet, what filenames to give the data files, how to install the Workbench on your computer, and how to save your work.

The tools for writing planets in Fed2 are a set of programs, with a graphical interface. You type the information onto the screen, or select options from menus or dropdown lists.
You use the tools offline to create files which you save onto your computer, then when you are finished submit them to us to be linked into the game.

The tools are pretty easy to use, and you can probably figure out the basics on your own without reading the manual. However, you will find it a lot easier to get the best out of the tools if you understand how they work.

The tools are currently available for Windows and Mac computers. This version of the manual is for the Windows editors.
PLANET FILES

The tools for writing planets in Fed2 are a set of programs, each one used to work on a different aspect of a planet. They are:

· Map

· Messages

· Events (covered in the Advanced Workbench Manual)

· Objects (covered in the Advanced Workbench Manual)

A planet doesn’t have to have all of those elements, of course - but it does have to have a map, otherwise there is nothing for players to stand on!

A star system has one space map and one or more planet maps. As a Founder you can only have one planet in your system; at later ranks, you will be allowed to have more than one.

PLANET CHECKER

The Workbench includes a program called Tesla that you use to check your planet files for errors. The instructions for using Tesla are later in this manual.
FILENAMES

For each map you need a file name - the physical name of the file that you save onto your computer. For the planet map, you should give a filename that matches your planet name, for example the map file should be called bodville.loc and the message file bodville.msg. If you create objects or events, those files must also have the same name as the map file: bodville.obj and bodville.xev.

Filenames should be all lowercase.

Filenames cannot have spaces in them, so if your planet has two words in its name you will need to remove the space when naming the file. The planet New World would have filename newworld.loc.

The space map should always be called space.loc and if it has a message file, that will be called space.msg; object and event files that go with the space map will be called space.obj and space.xev.
3.2 INSTALLING THE WORKBENCH

SYSTEM REQUIREMENTS

The Fed2 Workbench runs under Windows XP, Windows 7 and Windows 8. It will also run under the Wine emulator on Linux. There is also a Mac version available.

Graphics resolution: 1024 x 768 minimum - any smaller and the editor’s window won’t fit on your screen.

Memory: Each of the Workbench editors are small applications that do not require much memory. The exact amount will vary depending on which version of Windows you are using.

Computer space: 10 meg

DOWNLOADING AND INSTALLING THE TOOLS

You download the Workbench tools from the web site at http://www.ibgames.net/fed2/workbench/windows/index.html. The download file is called Fed2Workbench.zip. Once you have downloaded it, double-click the file to open up the zip, then click Extract all files. Windows will ask you what folder you want to put the Workbench into. If you want to keep it together with other Fed programs such as FedTerm, choose C:\ibgames\Workbench, but that’s up to you! Then click Extract to unzip the files.

The Workbench contains the following programs:

· Location Editor - LocEd.exe

· Message Editor - MsgEd.exe

· Object Editor – ObjEdit.exe

· Event Editor – EvEdit.exe

· Tesla file checker – Tesla.exe

You can run all of these programs at the same time, depending on what you are working on - indeed, if you are working on more than one set of files you could run two copies of an editor, subject to the resources of your computer, although this might get a bit confusing.

Also included in the installation file are some extra files which the location editor needs in order to run, a set of files for one of the stock planets, so you can see what a real planet looks like, and some sample object and event files for when you are ready to write events.

NOTE: The Workbench installation requires you to have the Microsoft Visual C++ redistribution package on your computer. This should have been installed along with your Windows software, but if it was not then you will get an error message when you run the Workbench editors.
If you do get this, then you will need to go to the Microsoft website here: http://www.microsoft.com/en-us/download/details.aspx?id=5555 and follow the instructions to install the redistribution package. Once you have finished, you can then use the Workbench.

RUNNING THE WORKBENCH TOOLS

Open the folder that you unzipped the Workbench into and double-click on one of the program files to run that editor.
You can create desktop shortcuts by right-clicking on a program, selecting Create Shortcut from the menu, then dragging the shortcut onto your desktop.

3.3 SAVING YOUR WORK

All of the different editors use the same concept when it comes to saving your work. You need to think of your work in three different parts:

· The current location or message you are working on

· The temporary file held in memory of all the locations or all the messages contained in the current file

· The permanent file on your computer which is saved after you finish working on it.

Saving your work is a two-stage process - first you move the current location or message into the temporary file in memory, and then you save the whole file onto computer.

Stage 1 is when you click away from the current location, by clicking on the map to select another location to work on, or click the ‘Add/Update’ button in the message editor. This means the changes you just made to the current location/message, are moved into the temporary memory for the whole file and held there so you can work on another location/message in the same file. This happens automatically for the location editor; for the message editor, you will be asked if you want to save the changes you just made, or reject them and go back to the way it was before.

Stage 2 is when you save all of the work held in the temporary file in memory to your computer, and you do this using the ‘File|Save File’ menu item for the editor you are using, or pressing ‘Ctrl-S’. You need to do this frequently to protect against accidents, crashes and so on.

WHERE TO SAVE YOUR WORK

The editors all default to looking in the folder you run them from, but you are advised to set up a sub-folder in which to save the files. That way, the data won’t get mixed up with the program files. If you happen to have more than one Fed2 character, so you want to work on more than one star system, create a separate sub-folder for each system - otherwise the space maps will get mixed up.

It doesn’t matter what you call the sub-folder - it’s not relevant to the game itself - but I advise you to use the system name to keep things clear.

The editors will remember where you last saved or loaded a file from.

BACKING UP YOUR WORK

Just as Fed2 is in development, so these tools are in development. New features are added frequently, and although we test the tools before issuing them to you, sometimes things won’t work as they are supposed to.

In order to make sure your work doesn’t get irretrievably mangled by a rogue editor, I recommend you back your files up before each session of working on them. Just copy them to another folder on your computer. Then if anything goes wrong, the most you will have lost is one session’s worth of work.

ILLEGAL CHARACTERS

As explained earlier in this manual, when you save your work, the editor will strip out any non-standard characters and replace them with a ? or a #. If it did not do this, the files would not load into the game. You can then fix the files by turning the # symbols back into the character they were meant to be - just as you would fix any other typo.

PART 4 - THE LOCATION EDITOR

4.1 INTRODUCTION TO THE LOCATION EDITOR

This part of the manual teaches you how to use the location editor to create your planet map and space map. It explains the layout of the screen, how to add locations to the map, setting movements, specifying information about locations, information for the whole map, how to add a second planet to your system, and the controls that let you edit individual locations and save and load maps.

4.2 ABOUT THE LOCATION EDITOR

The location editor is used to create and edit the maps which make up your star system, and on which the players walk around (or fly through).

To run the location editor, find the folder where you installed the Workbench and run the program LocEd.exe.

PLANET AND SPACE MAPS

When starting a planet from scratch, it is most common to build the planet map first, then the space map. These instructions tell you what to do when you are working on a planet map.

In cases where you have to do something different for a space map, the additional info for the space map is displayed in a box, like this paragraph.

That makes it easy for you to go through the manual a second time to build your space map.
THE SCREEN
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The main part of the window is taken up by the map. Each square on the map represents one possible location. A square which is being used as a location is grey and white with a black border; unused squares have a cross in them which indicates they are empty, undefined locations. The location you are currently working on, called the current location, is a solid black square.
Move the cursor over the map and as it passes over a location, the number of the location will display in the information bar at the bottom of the screen. If the square is being used you’ll also see the location name.
Underneath the map is a panel where you type in the name and description of the location you are working on. There is also a tab to switch this to displaying vocab information (but that’s something you can’t use until you write events, so ignore it for now) and a tab for a listing of the locations you have written, which is explained later in the manual.

On the right of the map is an information panel. There are three pages:

· Map - information about the overall map.

· Exits - the movements for the current location.

· Events & Properties - properties and event triggers for the current location.

To switch between the pages, click on the tabs down the side.

Above the information panel are the buttons you use to set the movements between locations: compass directions, in, out, up, down and non-adjacent.
At the bottom of the information panel is a counter that tells you how many locations the map has - very useful to make sure you don’t go over your limit.

The status bar at the bottom of the window gives useful information about the map and the specific location the cursor is over.

When the location editor starts, the map is blank, waiting for you to load in an existing map or draw a new one.

CHANGING THE FONT

You can change the size and typeface used for the location name and description displays by selecting ‘Options|Font’. The editor does not remember the font settings over sessions so if you don’t want to use the default font, you will have to set it every time you fire it up.

You can also change the background colour of the map with ‘Options|BackGround Colour’ – this does get saved between sessions.
4.3 DRAWING A MAP

SETTING UP A MAP

Before you can start work on your map you have to tell the editor the name you want to give the planet and system, and whether you are working on a planet map or a space map. To do this, select ‘New’ from the ‘File’ menu. This brings up a box where type in that information.
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The default for the type of map is ‘planet’ so if that’s what you are working on, you don’t have to alter this setting.

Type the system name and planet name into the box, then click the ‘OK’ button. Don’t worry, you can edit the planet and system names later if you want – they are in the information panel on the right of the screen.
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For a space map, click the ‘space’ button then type in the system name. Make sure you use the same system name for the planet map and the space map.
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Note that once you set a map up as a planet or space map you can’t go back and change it – so get it right!

DEFINING LOCATIONS

To define a location, simply click on a square on the map. This changes the square to solid black, which indicates that it’s now used. You can then fill in the information about the location (which is explained below). Whatever you enter is saved for that location as soon as you click away.
STOREROOM

On the planet map, you should reserve location 0 - that is, the top left square on the map - as a storeroom, a location where objects and mobiles can be stashed when they are not being used. You need to draw this location in even if you don’t have objects or mobiles yet. The storeroom is included in the count of the number of locations used. This should not be a room that players can access, so don’t have any movements leading into it.

Space maps do not usually need a storeroom - the only use for one will be when space mobiles are implemented, if you wanted to stash a mobile out of the way somewhere and only bring it out under certain circumstances.

POSITIONING YOUR MAP

With the exception of the storeroom in location 0, you should not draw your map so that any of the locations press up against the edge of the map - it makes FedTerm’s auto-mapping look funny, and it’s also good practice to leave room for expansion in all directions. The Tesla planet-checker will warn you if there are any locations pressing against the map edges.
THE CURRENT LOCATION

Anything you set in the location information panel, whether it’s movement or other data, will operate on the current location. The current location is either the last location you created, or if you are editing previously created locations, the last location that you clicked on. It shows up as a solid black square on the map.

The location remains selected until you click on another location then the new location becomes the current location.

If you change your mind about changes you have made to the current location, selecting ‘Restore Location’ from the ‘Location’ menu resets it – but this will only remove changes you made while it was the current location. Once you click away, it won’t work.
4.4 SETTING MOVEMENTS

There are several ways to set movements between locations:

· Set a direct compass direction movement using the movement buttons on the top left of the screen

· Set an in, out, up or down move or a non-adjacent move by pointing to the destination location on the map

· Type the destination location number into the information panel

Whichever method you use, a movement must link two locations - you cannot have a movement that leads nowhere. If you do, players walking around your map will fall down a hole and never be seen again.

DIRECT MOVEMENTS

To set a movement linking two adjacent locations together using the standard compass directions, select a location then click on one of the movement buttons. The specified move will appear on the map. To remove a movement you have already set, just click the arrow again.
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The line connecting the two locations will have an arrow at one end to show the direction of the movement.
NON-COMPASS MOVEMENTS

To set an in, out, up or down movement, select the location then click on the movement button you want to use. The cursor will change to a large cross. Click on the destination location to set the movement. The destination location can be an existing location or an empty square – but if it is empty, remember to turn it into a location later!

A location with an up or down movement set on it will show as blue on the map.

You should make full use of the in and out directions to help players explore buildings. On a street outside a building, IN should lead inside, although this only works if there is only one possible building to walk into from that location, obviously! Inside a building, OUT should lead back to the street, assuming there is only one way back outside. IN might lead further into the building, too.

NON-ADJACENT MOVEMENTS

To set a compass direction that leads to a non-adjacent location, select the location, then click the movement button for the direction you want the exit to go in, followed by the N/A button. This changes the cursor to a large cross. Click on the destination location to set the movement. The destination location can be an existing location or an empty square – but if it is empty, remember to turn it into a location later!

If you have set a non-adjacent movement the arrows on the movement line show the direction but not the destination, so check they go to the right place and have a return if appropriate.

TYPING IN THE DESTINATION LOCATION NUMBER

Sometimes it is easier to just type in the location number that a movement should lead to, particularly if it’s on the other side of the map. To set movements this way, select the location then click on the ‘Exits’ tab of the information panel. This page has boxes for all the compass directions and the non-compass moves. Just type the destination location numbers into the relevant boxes. Movements set using the buttons also show on this page – it shows all movements – and you can change an existing destination by editing the number.
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ONE-WAY AND TWO-WAY MOVEMENTS

As explained above, setting a movement for a specific location sets a direction OUT of the location, not INTO it. In order to make a proper link between two locations, you need to put in the reverse direction as well. The arrows on the map show you whether you have set a one-way or a two-way direction, although these won’t help if the only movements on a location are in, out, up or down.
You can, of course, deliberately put in a one-way link, where the movement only leads in one direction, but this technique should be used sparingly, and only where there is a logical reason for it. Remember that players using FedTerm will see the map with a link between two locations, but the line won’t have little arrows on the links to indicate a one-way link!

Tesla will warn you about one-way movements so you can fix any that were not deliberate.

HIDDEN EXITS AND MAZES

Many players use FedTerm, which has auto-mapping. This means that all the valid compass-direction exits from a room show up on the map. You can’t confuse players by not telling them about an exit in the location description (unless its an up, down, in or out movement).

The traditional kind of maze, where movements lead back to the same location, should also be avoided for the same reason. Players can easily see from the FedTerm map whether they have moved to a new location or stayed in the old one, so mazes are not a challenge any more. You are going to have to be a bit more sophisticated if you want to make exploring a challenge!

NO-EXIT LOCATIONS

It is possible to have a location with no exits at all - no way to walk in or out of the room. Perhaps it’s a storeroom where you stash objects, which you don’t want players to access; perhaps it’s a room that can only be entered and left using events. But be careful of rooms you can walk into but not out of – you don’t want to trap players.
NO EXIT MESSAGES

The game has two standard no exit messages that are sent to players when they try to move in an incorrect direction - one for when they are on the ground, and one in space - but you can specify a different message for a location. How to do this is explained later in the manual in the section about the message editor.

4.5 INFORMATION FOR LOCATIONS

As well as drawing the locations on your map and setting movements between them, you have to provide information for each location. You can do this as you go along, for each new location you draw, or you can draw a bunch of locations then go back and fill in the information - whichever method suits you!

The information panel always displays the information for the current location. If you want to work on a different location, click on the one you want, to select it.

LOCATION NUMBERS

The number of the current location is displayed above the movement arrows. You cannot change this; it is determined by the map square in which you have placed the location. Therefore, the numbering of the locations on a planet is not consecutive, and there will be gaps in the run of numbers (unless you have designed a very long, thin planet with all the locations on the same row!). You can see the number for any location by moving the cursor around the map – the number of the location the cursor is over displays in the information bar at the bottom of the screen.
LOCATION NAME

This is the name of the location - eg Shuttle landing pad, Main road, Bodville Bar and Grill, etc. The name can be up to 63 characters long. All locations must have a name. If you save the map without naming the location, the editor will put some Xs into the name field as a placeholder.
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DESCRIPTION

This is the description of the location, up to 1,000 characters long. All locations must have a description. If you save the map without writing a description, the editor will put some Xs into the description field as a placeholder. The editor tells you how many characters you have typed so far, and a progress bar gives a visual indication.
The description should tell the player what kind of place the location is, what she might be able to do there, and which way she can move.

Above all, the description is your chance to make the player feel she really is walking around on another planet. You can describe what it is like - what she sees, what she hears, what she smells, even. Think about what the ground feels like underfoot. Is the location crowded with people, or empty? What kind of people - human or alien, rich or poor ​- and what are they doing? You can also include interesting facts about the planet, or that area of the planet.

Do not use any characters with accents on them, “curly quotes”, or other non-standard ascii characters. The game won’t accept them. If there are any in your description, they will get replaced by a ? when you save the map.
You can have more than one paragraph in the description - just press return when you want to start a new paragraph. You cannot have blank lines, so to make it clear to players where the paragraph break is, it is a good idea to indent the first line of each paragraph with three spaces, like this:

   The southwest corner of the spaceport is reserved for craft belonging to members of the Martian City Council. Some of the vessels parked here are extremely fancy - clearly, there are perks to being on the planet’s ruling body.
   The landing area is north.

That’s the style we use on all the Solar System planets.

If for some reason 1,000 characters is not sufficient for a location description, it is possible to make additional text appear when a player walks into a room, using events, but you will have to wait until you are a Technocrat!

VOCABULARY
There is a tab under the map marked Vocabulary, but you won’t be able to use this until you are a Technocrat, so ignore it for now – it’s are covered in the Advanced Workbench Manual.

PROPERTIES

There are a number of properties which can be set for a location which make it in some way special. Note that some of these have not yet been implemented in Fed2. Click the ‘Events and Properties’ tab in the information panel on the right of the screen. Ignore the top part of the screen about events for now.
Under those is the list of properties available. The first three can only be used on space maps; the rest of the list can only be used on planet maps. The ones you can’t use are greyed out.
Space Map Properties
· Space - a space location. All locations on a space map must be space locations; the editor will set them automatically and you can’t change them.

· Link - an Interstellar Link, which links your system to the rest of the Galaxy and lets players visit. The space map must have a link, but only one.

· Fighting - a location in which ship fighting is allowed. This property cannot be set on a link location or a planet’s orbit.

· Ignore the Peace property – that is no longer used.
Planet Map Properties
· Ship Yard - a location where players can buy a new spaceship. You are only allowed one per planet. You don’t have to have a shipyard.

· Ship Repairs - a ship repair yard.
· Weapons Shop - a place that sells missiles for ship fighting.

· Hospital - One per planet. Insurance is automatically sold in the hospital location. (Note that if you have more than one planet in your system and both of them have a hospital, the game will ignore one of them.)
· Exchange - a trading exchange. One per planet. A planet does not have to have an exchange, but without it the planet will not have an economy.

· Cafe/Bar - A location where ale and pizza can be bought. Must have at least one on every planet. The more, the merrier!
· No Teleport - Players cannot teleport in or out of the location. 
· Custom - Used in conjunction with events. Ignore this for now.
The last two properties are for Sol planets only. Do not use them. Player planets do not have Armstrong Cuthbert offices or pickup points for Akaturi jobs - the AC office is automatically set up on the landing pad for cargo jobs, and Akaturi jobs are Sol only.

A location can have more than one property – just click as many of the boxes as appropriate.
Warning: do not set your exchange and your ship yard in the same location – it causes a conflict between buying the commodity called sensors, and installing sensors in your ship!

4.6 MAP INFORMATION

When you set up your new planet file you specified the system name and (for a planet map) the planet name. These are displayed in the map panel on the right. There is also a little picture which reminds you whether the map is a space or planet map. Note that you can’t switch from one to the other – if you make a mistake you will have to start again.

Note that you must use the same system name for the planet and space maps. Check you have spelled it the same on both maps.
For a planet map you also need to specify the location of the landing pad, which can be any location from the planet map, and the orbit location, which is the number of the location on the space map. Just type the numbers into the boxes.
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You won’t be able to save a planet map unless these location numbers are filled in. The editor will also complain if the landing pad location you have specified doesn’t exist.

If you haven’t designed your space map yet you may not know the number you plan to use for the orbit location – in which case, put any number in the box for now, then go back and change it later, once you’ve done your space map.

You do not have to type in the location numbers for a space map.

4.7 MAP LISTING
The listing tab under the map switches the screen to show you a list of the locations on the map. You can see the title, description, movements, properties, etc for every location. You can’t make any changes to the listing, it is simply a representation of what the map file contains.

The listing also shows the version number of the map. This is a number which goes up by one every time you save the map. It lets you keep track of whether the latest version of your map has been linked into the game yet - type ‘VERSION’ when in your system and you will see the version number of the planet or space map.

You can copy some or all of the listing to the computer’s clipboard and then paste it into a word processor or test editor - use ‘Ctrl-A’ to select the whole listing, then ‘Ctrl-C’ to copy it.
4.8 MAKING CHANGES ON THE FLY

Once your system is linked into the game, you can make changes to your planet in the game, without waiting for new files to be linked into the game. This instant redecoration affects the location you are in, either on your planet or in your space.

You can change the location name with the command ‘CHANGE NAME new_name’ - for example, ‘change name Big Bertha’s Bar and Grill’. You can change the description of the room with ‘CHANGE DESC new_description’ - for example ‘change desc This long and winding road winds along for a long way, linking the Fool’s Hill to the east, to Strawberry Fields which is south.’
The ‘CHANGE DESC’ command has some restrictions. You are limited to the number of characters the game will accept for any input, so you won’t be able to use all the 1,000 characters that the Workbench location editor allows for a description. You will also be unable to split the text up into paragraphs - the whole description will be one paragraph. And you won’t be able to put any spaces at the start of the descriptions, to indent the text.

You can also toggle the fighting property on a space location with ‘CHANGE FIGHTING’.
You can decide whether these changes should be permanent or whether they should disappear at reset. Normally, the changes are just temporary and when the game resets, the planet files will be loaded in as they were before. So you could redecorate a room for a party or other special event, safe in the knowledge that the decor will revert to the its normal state once the festivities are over.

However, if you want your change to stick around, then use the command ‘SAVE MAP’ and the current version of your planet will be saved to disk, and will load back in at reset. Note that the command only affects the map you are on, so if you have made changes to both planet and space locations, you will need to use the command twice, once on the ground and once in space. This will not affect the file version number for the map.

If you save the changes then you must remember to make the same changes to your planet files using the Workbench location editor - otherwise the files on your computer won’t match the files in the game.

4.9 WRITING A SECOND PLANET FOR YOUR SYSTEM

When you become a Mogul you can have a second planet in your star system, and at Gengineer you can add a biological planet. Further planets can be added at later ranks.

You make the map for a new planet like you did the first one. Save it into the same folder on your computer as the first planet files.

Give it the same facilities - lots of bars, an exchange and so on. It does not have to have a hospital.

You will need to edit your space map to make an orbit location for the new planet on your space map, and also add directions from the link to the new planet’s orbit.

4.10 MISCELLANEOUS
COPYING AND PASTING A LOCATION

If you have a map which contains a lot of similar locations, you can duplicate a location without having to type in the same data over again, by copying and pasting it.

Select the location you want to copy, then use ‘Location|Copy’ to copy the data to the clipboard. Then click on the location where you want to place the copied data, and use ‘Location|Paste’. All the information (except the location number and movements) will be copied to the new location. If there was already any data in the location where you paste, it will be overwritten.

You can also use this to copy locations from one map to another.

RESTORING A LOCATION

If you make any changes to a location - either to the movements, the name or description, the properties and so on - you can revert to the previous state of the location by using ‘Location|Restore Location’.

Once you have clicked away from the location then the restore option will no longer work.

DELETING A LOCATION

To delete the current location, select ‘Location|Delete’.

SEARCHING THE FILE

If you can’t remember where on the map you put your own personal office, or which location is the trading exchange, you can tell the editor to search the whole map to find either some text, or any location with a particular property on it.

To search for text, select ‘Map|Find Text’ or press Ctrl-F. In the box which comes up, type the text you want to find – a word or phrase. The editor will search through the file and will tell you about any locations where the description contains that text. The results appear in a box in the information panel on the right.

To search for a property, select ‘Map|Find Property’. Select the property you want to search for from the list. The editor will search through the file and will tell you about any locations which have that property. The results appear in a box in the information panel on the right.
4.11 FILE MANAGEMENT FOR MAPS

The ‘File’ menu has options to let you do all the file management-type things, like save the map, load another map, start a new map, and exit the editor.

SAVING YOUR MAP

When you have finished work on the map you have constructed, you need to save it for posterity. Indeed, you want to save your work frequently while you are working to guard against Windows crashing, sudden power loss, act of dog on your cables, and other potential mishaps!

If the map you are working on is a new map, select ‘File|Save As’ or press ‘Ctrl-Shift-S’ and give the file a name. The editor will supply the file extension .loc so you only have to type in the name.

Note: if you haven’t typed in the orbit and landing pad locations, you will be told to do it before you can save.
If you have already given the file a name, select ‘File|Save’ or press ‘Ctrl-S’ and it will be done.

When you save the map, any illegal characters (curly quotes, characters with accents and so on) will be replaced with a ?.

LOADING A MAP

To load a map into the editor, select ‘File|Load’ or press ‘Ctrl-O’ and then choose the file you want to open.

If you have made any changes to your current map since you last saved, you will be asked if you want to save it now.

STARTING A NEW MAP

To start a new map, select ‘File|New’ or press ‘Ctrl-N’. This wipes off the file you have been working on and presents you with the set-up box for a new map.

If you have made any changes to your current map since you last saved, you will be asked if you want to save it now.

Maps are always 64 x 64 squares. However, there is a limit on how many locations you can actually use, which varies depending on your rank, so you can’t fill the map up completely.

EXITING THE LOCATION EDITOR
To close down the location editor simply close the window or use ‘File|Exit’. If you have any unsaved data you will be prompted to save it.

PART 5: CHECKING YOUR PLANET WITH TESLA

5.1 INTRODUCTION
This section explains how to use the Tesla planet checker to find errors in your files.

5.2 ABOUT TESLA
Tesla is a program which checks your planet files and identifies errors that will cause problems in the game. It also gives warnings about things that may be mistakes.
It is important that you run your files through Tesla before you submit them to be linked into the game. You need to do this every time you send us files – even if you have only made a minor change to the files.

Here is what Tesla looks like when it checks a planet and finds no errors:
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To start Tesla, run the file Tesla.exe.
5.3 LOADING YOUR PLANET FILES
Select the 'File|Load' menu item, and find the folder in which you have saved the files for your system. Click on the folder and then click on the 'OK' button. Tesla will load in all the maps in the folder - normally that will mean one planet map and the system's space map, although Moguls and above may have more than one planet map. It will also load in the message files and event files associated with the maps.

The names of all the files loaded are listed in the panels on the left side of the screen.

Tesla will remember the location of your files over sessions.

5.4 TESTING THE FILES
Select the 'Actions|Check System' menu item and Tesla will go through the files and check them for errors. The results of the test will be displayed in the results window.

Tesla tests map files, message files and event files. If there are no errors, then Tesla will report on the details of the maps, including the number of locations, and the details of the link and exchange locations, and how many messages and events it found.

For each map, the report will conclude with "Test complete", in which case you know the map is safe to be submitted for linking to the game.

5.5 ERRORS AND WARNINGS
Errors are problems that will stop the files from loading into the game, or will cause serious problems. If Tesla finds an error, it will display a message in red telling you what the error is. For each map or message file, if it finds an error it will stop checking for any further problems. Error messages are displayed in red.

If Tesla tells you there is an error in your files, you must fix it and re-test the files (see below).

There is a list of all the things Tesla considers to be an error at the end of this manual.

Warnings are things that might be mistakes, but that the game itself won't object to, such as one-way movement links, or a planet without an exchange. Warning messages are displayed in blue. A warning won't stop Tesla from checking for further problems.

5.6 RE-TESTING
When you have fixed an error using the map editor, message editor or event editor, and saved the file, you need to load it into Tesla again. Use 'File|Load' as before.

Run the check again, to see if Tesla finds any further errors. Remember that it stops after the first problem, so if you have made several mistakes, you will have to keep on fixing errors and re-testing until it reports that everything is OK.

In between tests, you can clear the text out of the report window using 'Actions|Clear Display'.

5.7 TESLA ERRORS

Tesla doesn’t find absolutely everything you might have done wrong when designing your planet – it just looks at things we know will cause a problem in the game.

Here’s a list of the errors it looks for:
· Filenames with upper case letters in them

· Filenames with spaces in them

· No map with a filename space.loc

· Map titles that are in the wrong format

· Map titles that contain characters that are not letters or numbers

· Map titles that have capital letters in the wrong places

· Launch and Orbit information missing or in wrong format for planet maps, or filled in for space maps

· Launch and Orbit locations that don't exist

· Locations on space map that do not have the Space property

· No hyperspace link on space map, or more than one link

· Locations on the space map that have any of the planet properties set

· Locations on the planet map that have any of the space properties set

· More than one exchange on a planet map

· Movements that lead to non-existent locations

· Locations with Sol-only properties on them (ie courier and pickup)

· Locations with no-exit messages in the wrong format

· No-exit messages that do not exist in the message file

· Message file/event file section and category names that are not in the right format

· Events that call non-existent messages from the message file

· Events that refer to non-existent locations

· Events that call non-existent events

· Events that have information in the wrong format
5.8 CHANGING THE FONT
You can change the font Tesla uses by selecting 'Edit|Change font'. Tesla will remember your chosen font over sessions.

PART 6: THE MESSAGE EDITOR

6.1 INTRODUCTION TO THE MESSAGE EDITOR

This part of the manual teaches you how to use the message editor, and includes an explanation of the concept of categories, sections and message numbers, the layout of the screen, how to write a message, how to use the messages you write, how to edit messages, and save and load the message file.

ABOUT THE MESSAGE EDITOR

A message file holds paragraphs of text which are sent to a player at various points, either as part of an event, or as the no exit message for a location.

You can’t play with events until you each Technocrat, but you can customize the messages a player gets when she tries to go in a direction that has no exit. Your alternative no-exit messages are held in the message file.

Each map has its own message file, so if you want to customize the no-exit message in space as well as on the ground, you will need a separate message file to go with the space map. When you get a second planet as a Mogul, that will have its own separate message file, too.

FILENAMES FOR MESSAGE FILES

The message file always has the same filename as the map file it goes with, so for a planet called Bodville, with a planet map filename bodville.loc, the message file will be called bodville.msg and the space message file will be space.msg.

RUNNING THE MESSAGE EDITOR

To run the message editor, run the program MsgEd.exe.

THE SCREEN

The message editor looks like this when you first run the program:
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This is the Edit screen, where you write your messages.

The main part of the screen is split into two panels. The top is the input panel, where you type in the text for a message. The bottom is the display panel, which lists the messages in the section you are working on.

The panel down the righthand side will be explained as we go along.

You can also click on the Listing tab, which will show you all the messages in the file, in a form that is easy to proof-read.
6.2 WRITING MESSAGES

CATEGORIES, SECTIONS AND NUMBERS

Before you can write your no-exit messages, there is a concept you need to understand, and that is to do with the way a message file is structured.

Within each message file, the messages are separated into divisions called categories, which are then split again into sub-divisions called sections. You could think of the message file as being like a filing cabinet, with each drawer being a category, and each file inside the drawers a section - then the individual pieces of paper in the file are the messages themselves.

Within each section, the messages have a unique number which the editor assigns as you write the text, starting at 1 and using the next number for each new message in the section.

You cannot create a message without first assigning a category or section, not even if your file only has one message in it.

The purpose of categories and sections is to let you group the messages together in logical chunks. You are advised to make use of the categories and sections to group your messages into logical collections, and not just to bung them all into the same category/section. This makes it easy to go back later and add a new message to a section.

The more messages you have in your file, the more the benefit of splitting them up in this way will become apparent.

Give the categories and sections sensible names that describe what they are intended for and this will also make it easier to find a message if you need to come back and edit it later. The names should be one word each, with no spaces, and all in lower case. You can use numbers in the names but no punctuation. For example, the no-exit messages could go in a category called moves and a section called noexit.

COMMENTS

The message editor allows you to write a comment for each message as an aide memoire. A comment is a note about what the message is for. This is ignored by the game - it’s not even loaded into memory. You type your comment into the box at the top of the screen. Message comments can be up to 32 characters.

It’s not necessary for you to type anything at all into the comments section, but you’d be a fool if you did leave it blank! Use it to describe how the message is to be used - otherwise in three months time when you come back to make some changes, you won’t remember which message is which.
I repeat, you are strongly advised to type in detailed comments. Ignore this advice at your peril!

Here is an example of the sort of detail you should put into a comment:

Gunsmiths - loc 516 - no exit msg

YOUR FIRST MESSAGE

To write the first message in a file, run the message editor and do not load in any existing file; or select ‘File|New’ - or press ‘Ctrl-N’ - to remove any existing file. Then follow these steps:

· Click on the category box at the top right of the screen and type in the category name you want to use, then click on the section box underneath it and type in the section name. They should be all lower case, letters/numbers only, and no spaces.
· Click on the comment box and type the brief but meaningful comment that will describe what the paragraph of text is for. Comments can be up to 64 characters.
· Click on the input panel – that’s the large panel just underneath the comment – and type in the message. As you type, the number of characters in the message will be displayed, and the progress bar will show you how much space you have left. Messages cannot be larger than 440 characters, and should not contain paragraph breaks - each message is just one paragraph of text.
· When you have finished typing the paragraph, click the ‘Add Para’ button. The paragraph will be added to the message file and will appear in the display panel on the lower half of the screen. The input panel will clear, and the message number will change to the next number ready for you to write another message.

· Don’t forget to save the file now! You can do this by selection Save from the File menu, or pressing Ctrl-S on your keyboard. If this is the first time you have saved the file you’ll be prompted for the filename, which should be the same name as you gave to the map file – ie bodville. Remember, filenames should all be lower case.
If you are writing a lot of messages then you may find it easier to write them in a word processor text editor and then copy and paste them into the message editor. That works but you need to make sure your word processor hasn’t used “curly quotes” because the editor won’t save them properly - they will be replaced by question marks.

EDITING MESSAGES

The bottom right panel shows you the categories and sections in your file. Click on a section, and the messages in that section will be listed in the display panel. Click on one of the messages, and it will be loaded into the input panel for you to amend.

You can then make any changes necessary, and click the ‘Update’ button to save your changes.
You can also use the text of an existing message as the basis for a new message. Click the ‘Next Number’ button and the text will remain but the number will change to the next available number - you can then save the message as new instead of overwriting the original. Alternatively, you can manually change the message number, but if you change it to a number that already exists, you will overwrite the text of the old message.

WRITING A SECOND MESSAGE

If you have just finished writing your first message, and you want to write a second message in the same category and section, then the screen will be all set up for you - just type in the new text and click the ‘Add Para’ button.

If you want to write a message into a different category or section, click the ‘Clear Cat/Sec’ button once to remove the section, and again to remove the category. You can then type in new section and category names. The number will be reset to 1.
If you want to come back to a file later and add a new message to an existing category/section, load the file. Click on the section in the file panel, and the existing messages will load into the display panel. The number will set for the next message so you can just type the new message into the input panel.
THE LISTING PAGE

If you click on the Listing notebook tab, the editor will display the complete listing of the file. This lets you scroll through the messages and read them in one go. You cannot make any changes to the messages here.

6.3 FILE MANAGEMENT FOR MESSAGES

The ‘File’ menu lets you do all the usual things with the file - Save (‘Ctrl-S’), Save As (‘Ctrl-A’), Load (‘Ctrl-L’), New (‘Ctrl-N’), and so on.

The ‘Edit’ menu has options to delete a paragraph of text, or delete a whole section or category.

The ‘Options’ menu has an option to let you change the font used in the input panel.
6.4 USING A MESSAGE

Having written your messages, you need a way to tell the game when to use them. With no-exit messages, you add that information to the location information using the location editor. Click on the location, click on the Exits tab, and then put the category, section and message number into the No Exit Message box. The information has to be in the following format:

moves.noexit.1

or the game won’t be able to find the right message. Type it all in lower case with no spaces in it.

Do this on all the locations that you want to have their own no exit message. You can use the same message on as many locations as you want.

Then, obviously, you need to save the map file.

PART 7 - CHECKLIST

7.1 INTRODUCTION

This part of the manual is a checklist of the things that you need to get right in order for your planet to be linked into the game.

Although the tools that make up the Workbench simplify the process of creating a new planet, they cannot make it completely fool-proof. There are plenty of mistakes you can make, and some of those mistakes will mean that your planet will not load into the game, or will not work correctly - or might even crash the game.

The Tesla planet checker will tell you about some problems but not all of them so you still have to do some checking yourself.

Note: this is only concerned with the things that will cause problems with the game, not with mere typos or errors; those you will have to check separately.

7.2 CHECKING THE SPACE MAP

· The space map file should be called space.loc - all in lower case.

· If there is a message file, it should be called space.msg - all in lower case.

· There must be an Interstellar Link - but only one.

· The locations should not be crammed up against any of the edges.

· There should be no movements that lead to a non-existent location.

· The system name should be the same as that shown on the planet map.

7.3 CHECKING THE PLANET MAP

· The planet map file should be named using your planetname, ie bodville.loc - all in lower case.

· If there is a message file, it should be named using your planetname, ie bodville.msg - all in lower case.

· The locations should not be crammed up against any of the edges.

· There should be no movements that lead to a non-existent location.

· The system name should be the same as that shown on the planet map.

· There must be an exchange - but only one.

· If there is a shipyard, there should only be one.

· The total number of locations for both space and planet map must not exceed 50 unless you have purchased extra.
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